Aims and Learning Objectives

This document aims to introduce the basics of image processing using Adobe Photoshop. When you have completed these exercises, you should be able to:

- retouch a damaged photograph;
- make selections using a variety of tools;
- adjust the hue and saturation of colours within an image;
- blend images to create a seamless montage;
- add and edit text.
Document information

Course files

This document and all its associated practice files are available on the web. To find these, go to www.bristol.ac.uk/is/learning/resources and in the Keyword box, type the document code given in brackets at the top of this page.

Related documentation

Other related documents are available from the web at:

http://www.bristol.ac.uk/is/learning/resources
Contents

Document Information

Introduction to Photoshop .......................................................... 1
The Toolbox ................................................................................. 2
Palettes ....................................................................................... 3
Getting help ................................................................................. 5

Colour management...................................................................... 6
Colour settings ............................................................................ 6
Choosing an RGB working space .............................................. 7
Monitor calibration ...................................................................... 8

Task 1 Selections using the Marquee Tool .................................... 10
Task 2 Selections using the Magic Wand Tool ............................... 11
Task 3 Selections using the Quick Mask mode ................................ 13
Task 4 Selections using the Lasso Tool .......................................... 15
Task 5 Manipulating colours .......................................................... 18
Task 6 Retouching a damaged photograph ...................................... 20
Applying the Dust & Scratches filter to the whole image .......... 20
Applying the Dust & Scratches filter selectively ........................ 21
Using the Clone Tool to correct the remaining blemishes ....... 22
Adjusting contrast and sharpening .............................................. 22

Task 7 Blending images using a layer mask and gradient .............. 23
Creating a new document ............................................................ 23
Blending the images ................................................................... 24

Task 8 Working with text layers .................................................... 27
Adding a text layer ...................................................................... 27
Adding a text box ....................................................................... 28

Appendix 1 Creating a customised map for a CMS website ........... 30
Examine an existing customised University map ....................... 30
Open and prepare a local version: ............................................. 30
Customise the map for your department or unit ...................... 31
Save your map: ........................................................................ 32

Appendix 2 Resolution and image size for printing ....................... 33

Appendix 3 Further resources ......................................................... 34
Adobe’s Photoshop tutorials ....................................................... 34
Web Photo Resizer .................................................................... 34
PIXLR ......................................................................................... 34
Introduction

There is little doubt that the use of digital images in learning, teaching and research projects is growing. Typical uses include: supporting lectures and other presentations; creating Web-based instruction and creating digital image archives. Another aspect of digital images is that they can be delivered on a variety of supports: PowerPoint, Web, image database, CD-ROM, and print. It is therefore important to be familiar with image digitisation processes in order to obtain images that will be ‘fit for purpose’.

This document shows you how to apply image enhancement techniques using Adobe Photoshop CS2.

Prerequisites

This document assumes that you are familiar with the use of a computer keyboard and mouse, Microsoft Windows-based products and the use of a Web browser such as Netscape or Internet Explorer.
Introduction to Photoshop

Photoshop is the ultimate Swiss army knife for all your imaging needs, from basic to highly sophisticated image editing. For example you can simply enhance a photograph (remove red eye effect and scratches, crop, etc.), or create a complex photo collage or a sophisticated Web interface.

The main components of the Photoshop work area are:

- **Menu bar** - contains menus organised by tasks. For example, the **Layers** menu contains commands for working with layers.
- **Toolbox** - contains tools for creating and editing images.
- **Options bar** – provides options for the currently active tool.
- **Active image area** (also called **Document window**) – displays the active open file. Several images can be open at the same time, but only one can be active at a time.
- **Palettes** – help you monitor and modify images. They can be nested by dragging the title tab of one into the body of another. Use the **Window** menu to show/hide palettes.

Other useful elements are:

- **Palette well** – helps you organize the palettes in your work area.
- **Status bar** – located at the bottom of every document window, it displays useful information about the image and brief instructions for using the active tool.
- **Context menu** – display commands relevant to the active tool, selection, or palette. You access them by right-clicking on an image or palette item.

The **Toolbox, Palettes** and **Active image area** can easily be moved around the workspace by clicking the top bar and dragging them.
The Photoshop CS2 Toolbox contains all the tools you need for manipulating and creating images, for example, making selections, cropping, drawing, painting, erasing, moving, magnifying, etc.

Some of the buttons represent families of tools rather than single tools. For example, the Rectangular Marquee Tool is the default for selecting geometrical shapes, but if you right-click on it, a palette pops out with more choices such as an Elliptical Marquee Tool.

Further options are available when you hold down the <Shift>, <Ctrl> or <Alt> keys as you use a tool. For example, hold down <Shift> to select a circular shape with the Elliptical Marquee Tool.
Palettes

Palettes are one of the main means of accessing many of the features of Photoshop. You can show and hide them using the Window menu. Alternatively, you can press the <Tab> key while holding down <Shift> to hide/show them all.

Palettes can be moved around or nested (stacked behind one another) by dragging the title tab of one palette onto the body of another.

To bring a palette to the front, just click its title tab.

You can also expand/collapse them by double-clicking on the title tabs.

If you don't like having palettes floating around, you may prefer accessing them from the Palette well. To add a palette to the Palette well, simply drag it into it as illustrated on the right.

Clicking on the right pointing arrow in the top right corner will bring out a menu specific to the active palette.

Two of the most useful palettes are the Layers palette and the History palette:

The Layers palette

Layers are an essential part of Photoshop and you need to think of them as the building blocks to every image that you create. Individual palettes and the toolbar can be displayed or hidden using the Window menu (those with a tick mark next to them are visible).

The Layers palette enables you to control elements of an image by assigning separate layers to each individual element. Layers allow you to work on one element of an image without disturbing the others.
The idea is that you stack layers (in the same way that you would stack sheets of acetate transparencies) containing the various elements that will form your final image. There are different types of layers:

- **Image layers** are transparent and may contain images or part of images. They can also be used for drawing, filling with colour, etc. They contain pixel information only.

- **Adjustment and fill layers** allow you to make colour and tonal adjustments to your image without permanently changing its pixel values.

- **Type layers** allow you to insert text in your image. A new Type layer is automatically added above the active layer when using the Type Tool.

- **Shape layers** are filled with solid colours and the outline is defined with a vector mask and/or a layer mask. A new Shape layer is automatically added above the active layer when using one of the shape tools (Rectangle/Rounded Rectangle/Line/etc Tool).

In addition, you can manipulate each layer individually by applying various styles and effects (blending, drop shadow, etc.), filters and masks.

**The History palette**

Every change that you make to your image is recorded in the History palette as a history state.
Creative image manipulation using Photoshop (photoshop-2)

Just click on a state in the History palette to go back to that state (alternatively drag the History state slider up or down to point to the state you wish to move to). The states below the one you click on are dimmed and will be discarded if you continue to work from the selected state.

You can also delete states by dragging them into the wastebasket icon in the bottom right corner of the palette (alternatively right-click on the name of the state you want to delete, then choose Delete from the pop-up menu). Notice that this action will also delete all the subsequent states.

By default, the History palette will remember 20 states. You can change this by going to Edit/Preferences/General.

Getting help

Photoshop has a comprehensive help tool (see illustration below). To open it, go to Help/Photoshop Help.

Adobe Photoshop Help Center
Colour management

Colour settings

One problem with imaging software is the issue of screen, scanner and printer inconsistency. For example, monitor brightness, contrast and resolution all affect the way an image is displayed. Photoshop includes features to help ensure that screen colours will, as far as possible, resemble the final image.

As a rule of thumb, the image mode should be set to **RGB Color** when working for screen display and **CMYK Color** for printing. To check this, from the main menu, select **Image/Mode**.

<table>
<thead>
<tr>
<th>Image</th>
<th>Layer</th>
<th>Select</th>
<th>Filter</th>
<th>View</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adjustments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply Image...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculations...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Size...</td>
<td>Alt+Ctrl+I</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Canvas Size...</td>
<td>Alt+Ctrl+C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rotate Canvas</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Crop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trim...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reveal All</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply Data Set...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trap...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The reason for this is the differing nature of colour creation between media.

Printers use **Cyan**, **Magenta**, **Yellow** and **Black** to simulate the full spectrum. This is known as the **subtractive** method; remove all of these colours and you will end up with white (hence the standard paper colour). Adding 100 percent cyan, magenta and yellow would, in theory, result in black. However, in practice, results are never perfect, so printers include black ink; this is also a more economical way to work.

Computer screens, along with other digital media such as scanners and digital cameras, replicate colour using the **additive** method. **Red**, **Green** and **Blue** are combined to create a range of millions of colours: Adding 100 percent of each colour results in white light, whereas 0 percent will render black, in other words, no light.

If converting from a screen image to a printed version, all changes should be made in **RGB mode** before a final conversion to CMYK, using the menu shown above. This will remove any colours that can only be displayed on screen, replacing them with their nearest printable equivalents. If you need to work on an image that has been saved in **Indexed Color** mode, you will need to convert it to **RGB Color** in order for it to be fully editable. **Indexed Color** uses a smaller palette to cut down on file size.

The advantage of working in **RGB Color** is that you have access to all the bells and whistles of Photoshop which would otherwise be hidden or greyed out in **CMYK Color**.
Choosing an RGB working space

The colour working space refers to the gamut (range of colours) that can be displayed or printed. This range varies for different RGB working spaces and for different devices and can be changed in Photoshop.

sRGB IEC-61966-2.1

sRGB is the standard colour space for PC computer monitors and is the colour space assumed by many applications (including Web browsers and Photoshop). However, it has a limited gamut, sufficient for on-screen use (e.g. Web design, PowerPoint presentations), but unsuitable for quality printing, since it clips colours in the CMYK gamut.

Adobe RGB (1998)

Adobe RGB (1998) has become the recommended RGB editing space for RGB files that are destined to be converted to CMYK for print output. It provides a much wider gamut and consequently it has a much better ability to capture very deep or bright colours.

The figure on the right shows the full colour gamut (billions of colours) visible to the human eye. A shows the typical Adobe RGB (1998) colour space and B the sRGB colour space.

As you can see, A covers a greater range of colours than B.

There are other RGB colour spaces that have a much wider gamut (Wide Gamut RGB), however, these are intended for highly specialised applications.

To summarise, you should stick to sRGB for images intended to be used on the Web or for on-screen presentations, and convert to Adobe RGB (1998) for images intended for print (after conversion to CMYK).

To change the RGB colour space from sRGB to Adobe RGB, go to Edit/Color Settings. In the Color Settings dialogue box, in the RGB drop-down menu (under Working Spaces) select Adobe RGB (1998) as shown below:

- To convert from RGB mode to CMYK, go to Image/Mode and select CMYK Color from the list.
Monitor calibration

The Adobe Gamma utility comes bundled with Photoshop and can be used to calibrate a monitor’s settings: RGB colour balance, brightness, contrast and white point (the point at which colour will be displayed as white).

To launch the Adobe Gamma wizard, go to Settings/Control Panel and double-click on the icon labelled Adobe Gamma.

The wizard will appear as follows:

Make sure the Step By Step (Wizard) radio button is checked and click the Next button to proceed.

Leave the default monitor profile selected unless you know of a better match for your screen, in which case click the load button and choose from the list displayed.

Click the Next button and follow the on-screen instructions to set the brightness and contrast of the monitor.

Again, click Next to display the Phosphors pop-up. This should be left unchanged, unless you know for certain that your monitor’s phosphors differ from the default option.

Proceed by clicking the Next button. Uncheck the View Single Gamma Only box and set the gamma (mid-tone) brightness of your screen for each primary colour by following the on-screen instructions.
Assuming you are using a PC, from the dropdown menu, select **Windows Default**. There is also a **Macintosh** option. The **Custom** setting is only available to Macintosh users.

Having clicked **Next** to continue, leave the **Hardware White Point** as displayed unless you know it is incorrect. Continue to the next screen, leave **Adjusted White Point** as set and proceed to the final screen. You have an option to view the screen with before and after settings, before clicking the **Finish** button to name and store your monitor’s new profile.

See Ian Lyons’ article, *Photoshop CS - Colour Management* (www.computer-darkroom.com/ps8colour/ps8_1.htm) for a more detailed introduction to colour management.
Task 1  Selections using the Marquee Tool

Objectives  To “frame” a selection with a clear geometrical shape, you can use either the Rectangular or Elliptical Marquee Tool.

Comments  Selecting parts of an image is an essential skill in Photoshop. It is often the starting point for further manipulations, such as combining images together and applying filters/effects or making tonal adjustments to part rather than all of the image/layer you are working on.

1.1 Select part of an image with the Marquee Tool:

- Open the photograph manneken_pis.jpg in C:\Training\Graphics\ and duplicate it (Image / Duplicate).
- In the Toolbox, right-click on the Rectangular Marquee Tool (right) and select the Elliptical Marquee Tool.
- Select an area of the image (for example the head of the statue) – it is easier to select from top-left to bottom-right.
  
  **TIP**: Hold down the <Shift> key as you draw your marquee, to obtain a circular or square shape, rather than an elliptical or rectangular shape.
- Reposition your selection if necessary by clicking inside it and dragging to a new position.

  **Note**  You can add to selections by holding down <Shift>, or subtract from a selection by holding down <Alt> (alternatively you can use the Add to selection or Subtract from selection buttons in the Options bar – see Figure 1).

- Experiment using the Add to selection, Subtract from selection options, modifying the feathering (Figure 1) and using the Rectangular Marquee Tool if you want.

  ![Figure 1 - the Marquee Tool Options bar](image)

  **Note**  Feathering creates a soft edged border around the selection that blends gradually into the background. This technique is known as vignetting.

1.2 Use your final selection to create a vignette image:

- Using the Set foreground / background color tools located in the Toolbox, set the background colour to white or black.
- Go to the Select menu and choose Inverse. This will inverse the selection so that the area outside your selection becomes selected (notice the marching ants around the edges of the image).
- Press the <Delete> key to get rid of the inversed selection area. You should be left with a cut-out of the statue blending smoothly with a black or white background.
- Close these images without saving.
Task 2  Selections using the Magic Wand Tool

Objectives  To select an area defined by colour.

Comments  The Magic Wand allows selections by colour-matching. It is particularly useful when selecting an area containing pixels whose luminosity values are close, such as a blue sky for example.

2.1  Select part of an image with the Magic Wand:

- Open the photograph willstower.jpg in C:\Training\Graphics\ and duplicate it (Image / Duplicate).
- In the Toolbox, select the Magic Wand Tool (see right).
- In the Options bar, select the Add to Selection option (Figure 2).

Figure 2 - the Magic Wand Tool Options bar

- Set Tolerance to 1 and make sure Contiguous is checked.

Note  The Tolerance option controls the range of pixels that will be included in the selection on either side of the pixel you click on. The Contiguous option only allows neighbouring areas to be selected. If it is unchecked, similar colours in unrelated parts of the image will also be selected.

- Click four or five times in different parts of the blue sky area, noting the low tolerance. Change the tolerance to 10 and continue; you will notice that the whole sky soon becomes selected, outlined by a marquee (Figure 3).

Figure 3 - sky selected using the Magic Wand Tool

2.2  Add a gradient to the selection:

- In the Toolbox, select the Gradient Tool (see right) – if it is not displayed, right-click on the Paint Bucket Tool and select it from the list.
Referring to the tool options bar, near the top of the screen, make sure **Linear Gradient** is selected (Figure 4).

![Linear Gradient](image.png)

**Figure 4 - the Gradient Tool Options bar**

In the **Toolbox**, click the **Set foreground color** square to launch the **Color Picker** palette. For optimum flexibility, ensure that the option **Only Web Colors** is unchecked. Choose a medium dark to dark colour and click **OK**.

Repeat for the **Set background color** square, this time choosing a lighter shade of the colour you selected for the foreground.

Place the cursor against the left-hand side edge of the blue selection and, holding down the left mouse button, drag the cursor in a straight line to the right edge of the sky and release.

You will notice that a gradient has been applied, but only to the selected area. If you are unhappy with the result, you can simply drag a new gradient over the selected area.

Click `<Ctrl> + D` to deselect the sky. Alternatively, go to **Select / Deselect**.

Close the image without saving.
Task 3  Selections using the Quick Mask mode

Objectives  To select an irregular area by filling it in.

Comments  Working in the Quick Mask mode, you can isolate an area by painting over it.

3.1  Select part of an image in Quick Mask mode:

- Open the photograph hockey.jpg in C:\Training\Graphics.
- Select the Edit in Quick Mask Mode icon, situated below the foreground/background Color Picker (Figure 5).

![Figure 5 - Standard/Quick Mask Mode icons](image)

- Select Brush Tool from the Toolbox.
- Click the Brush Preset picker in the options bar (Figure 6).

![Figure 6 - the Brush Tool Options bar](image)

- The Brush Preset picker displays brushes varying in hardness and diameter. Choose a hard brush (indicated by a sharp circle with hardness setting 100%), and set the size to 16.

Note  Using a soft-edged brush will result in unwanted feathering around the final selection.

- Paint over the area you wish to select, in this case the middle hockey player (ignore the hockey stick) Note how the selected area is highlighted in semi-transparent red (Figure 7).

![Figure 7 - Quick Mask applied to middle hockey player](image)
Creative image manipulation using Photoshop (photoshop-2)

- When you have finished, revert to the **Edit in Standard Mode** (see Figure 5) – notice the marquee (marching ants) around the hockey player and around the edges of the image.
- If necessary, tidy up the edges by returning to **Edit in Quick Mask Mode**, using the **Brush Tool** to add to, and the **Eraser Tool** to subtract from the selection.
- Once you are happy with your selection, make sure you return to **Edit in Standard Mode** and in the **Select** menu, choose **Inverse**.

### 3.2 Create a simple photo montage:

- Open the photograph `royalfort.jpg` in C:\Training\Graphics\.
- Return to image `hockey.jpg` and, having selected the **Move tool** (see right), place the cursor on the highlighted hockey player and drag the selection on to the Royal Fort image. A new, independent layer will be created.
- Position the hockey player where you want it on the Royal Fort image.
- Check that the top layer containing the hockey player is highlighted in the **Layers** palette.
- ‘Clone’ the flowers surrounding the hockey player, and use them to paint over the join in the images.
- Choose the **Clone Stamp Tool** in the Toolbox, and in the **Options** bar set the **Opacity** to 100%, and select the **Use All Layers** check box (Figure 8).

![Figure 8 - the clone stamp tool option bar](image)

- Click the triangle next to the **Brush Preset picker** and choose a soft-edge brush tip (for seamless blending) with an an appropriate size: around 50-70px in this case.
- Hold down the `<Alt>` key and click in an area you wish to sample from (flowers in this case). Release the `<Alt>` key and move the cursor over to bottom of the hockey player’s legs and click, several times if necessary, to cover the flaw (Figure 9).

![Figure 9 -Choosing a suitable sample to hide a join](image)

**Note**  
The **Clone Stamp Tool** works by sampling content in an area and copying (cloning) them to a damaged area. Unchecking the **Aligned** option allows the same sample to be pasted again and again anywhere on the image. When checked, a map of the whole image will be stored.

- If any traces of hockey stick are visible in the player’s hand, try using the same technique to remove them.
- Save the image as `success.psd` in C:\Training\Graphics\.
Task 4  Selections using the Lasso Tool

Objectives  To explore a shortcut to select a well-defined but irregular shape.

Comments  The Lasso Tool is useful for selecting irregular shapes. There are three versions which can be found under one icon in the Toolbox.

- The default Lasso Tool is a free-hand tool useful to select very detailed edges and requires a good deal of practice and patience! To use it, hold down the left mouse button and drag a line around the desired area. Then release to make the selection.

- The Polygonal Lasso Tool enables you to select a series of short, straight line segments, which makes it better to select shapes with a smoother edge. To use it, click the left mouse button once and move the mouse around the image, clicking each time you change direction. A series of nodes will be created to join the lines. When you arrive back at the starting point, click on the first node to create the selection.

- The Magnetic Lasso Tool has as sensing area (that can be changed in the Options bar). When you move the cursor along the edges in a picture, the Magnetic Lasso can sense where that edge is and create a selection that follows it. It is probably the most useful of the three lasso tools.

4.1  Make a selection with the Magnetic Lasso Tool:

- Open the image autumnleaf.jpg in C:\Training\Graphics.
- Select the Magnetic Lasso Tool (right-click on the Lasso Tool icon in the Toolbox and choose Magnetic Lasso Tool).
- In the Options bar, make sure the Feather option is set to 0px and accept the default Anti-alias, Width, Edge contrast and Frequency options (Figure 10).

![Figure 10 - Magnetic Lasso Tool Options bar](image)

Note  You can change the settings in the Options bar for the Magnetic Lasso Tool: Feather creates a soft edged border around the selection; Anti-aliased smooths the jagged edges of a selection; Width sets the radius of the area where the tool looks for the edge; Edge Contrast specifies how much contrast the tool should look for in finding the edge and Frequency specifies how often locking points are laid down.

- Place the cursor anywhere on the edge of the main leaf, release the mouse button and drag the cursor around the leaf—notice how the tool automatically follows the edge created by colour or tone contrast.
- If you make a mistake, just press <Delete> to undo a segment. Where there is no contrast for the Magnetic Lasso Tool to follow, regularly click on the edge to increase the frequency of locking points.
- When you have come full circle, click the node at the starting point to make the selection.

4.2  Create a simple montage

- Leaving the selection active, open image C:\Training\Graphics\grass.jpg
➢ Return to the autumn leaf image and using the **Move tool** drag the selection on to the grass image, positioning it in the centre (Figure 11).

![Figure 11 - Leaf superimposed on grass background](image)

➢ Working in the **Layers** palette, make sure the leaf layer is highlighted, and click the small back triangle to the right of the **Opacity** box to launch a slider (Figure 12).

![Figure 12 - Opacity settings in the Layers palette](image)

➢ Move the slider gradually to the left to increase the transparency of the layer. Reset to 100%.

### 4.3 Duplicate the leaf layer

➢ Working in the layers palette, ensure the leaf layer is selected, then drag its icon on to the new layer icon

➢ Working in the top menu, select **View** and make sure the **Snap** option is unticked.

➢ Use the Move tool to drag one leaf layer away from the other, thus rendering both visible (*Error! Reference source not found.*).

![Figure 13 - Repositioned duplicate layer](image)

### 4.4 Transform one of the leaf layers.

➢ Make sure the top leaf layer is selected.
Working in the top menu, select **Edit / Transform / Scale**.

Hold down shift key and drag one of the corner sizing handles inwards and outwards to resize the leaf without changing its proportions.

If required, place the cursor inside the sizing area and drag to reposition the layer.

When the desired size has been achieved, click `<Enter>` to commit the change.

**Note** Resizing upwards will result in pixelation, so should be performed sparingly.

Select **Edit / Transform / Rotate**

Working outside the sizing area, left-click, hold and drag the cursor left or right to rotate anticlockwise or clockwise, respectively.

Place the cursor inside the sizing area, left click, hold and drag to reposition the image or move the centre point of rotation (Figure 14).

![](image1.png)

**Figure 14 - Rotating a layer**

**4.5 Apply a filter**

Flatten the image by selecting **Layer / Flatten Image from** the top menu.

From the top menu, select **Filter / Artistic** choose an effect and experiment with its settings. Figure 15 demonstrates the **Cutout filter**. This effect simplifies colours and edges to give the effect of a screen print, or at its simplest settings, shapes cut out of paper.

![](image2.png)

**Figure 15 - Cutout filter applied to flat image**

**Note** Filters can also be applied to individual layers.

Save the image as C:\Training\Graphics\*leaves.psd*
Task 5  Manipulating colours

Objectives  To change the hues and colour-saturation within whole images and individual colour channels.

Comments  This is achieved by the addition of a Hue / Saturation adjustment layer and requires no use of selection tools.

5.1  Open the photograph crayons.jpg in C:\Training\Graphics\.

5.2  Add a Hue / Saturation adjustment layer

- Click the Create new adjustment layer icon at the bottom of the Layers palette and choose Hue / Saturation. This will launch the palette shown in Figure 16.

5.3  Adjust the hue and saturation of the whole image:

- Making sure Master is selected in the Edit menu, gradually move the slider labelled Saturation to the far left. Note that the colour gradually drains from the image, to create a greyscale version.

- Move the Saturation slider gradually to the far right, noting how the image gradually becomes over-saturated with colour.

- Move the Saturation slider to the point you feel most appropriate (0 if no adjustment is deemed necessary).

- Experiment with the Hue slider, noting the shift of each colour along the spectrum, before resetting it to 0.

5.4  Adjust individual channels

- Select the Yellows channel from the Edit menu (Figure 17).
Slide the **Saturation** slider to the far left. Note how each instance of the colour yellow gradually becomes greyscale. Replace the slider at 0.

Gradually move the **Hue** slider to the left, noting how all the yellows move through the spectrum, without affecting other colours. Settle on a value of –25, to replace the bright yellow crayon in the foreground with an orange version.

**Note** Where shadows occur in the image, applying too great a change will render the image unnatural. You can, however, mask areas you do not wish to affect by making a selection, using the tools covered in tasks 2.- 5.

Experiment, repeating the above processes for other channels, before closing the image without saving.
Creative image manipulation using Photoshop (photoshop-2)

Task 6  Retouching a damaged photograph

Objectives  To remove scratches and dust spots from an image.

Comments  Old or neglected photographs often suffer from a variety of defects (scratches, dust spots, creases, etc) that devalue them. Photoshop provides a range of tools to correct these defects and with a little bit of practice it is easy to repair damaged images.

6.1  Open a new image:

- Go to File / Open and in C:\Training\Graphics open the file old_image_before.jpg and make a copy of it using the Image / Duplicate command.
- Replace the suggested name with old_image_after and close old_image_before.jpg.

Applying the Dust & Scratches filter to the whole image

6.2  Create a copy of the Background layer by dragging the background layer onto the Create a new layer icon

You should now have a Background copy layer above your original Background layer.

6.3  Remove dust and scratches:

- Make sure the newly created Background copy layer is selected in the Layers palette.
- Go to Filter / Noise / Dust & Scratches to open the Dust & Scratches dialogue box (Figure 18).

![Dust & Scratches](image)

Figure 18 - the Dust & Scratches dialogue box
Make sure the Radius and Threshold sliders are all the way to the left to start with.
Slowly move the Radius slider to the right and observe the changes: the spots disappear, but the image loses its inherent noise or film grain. Settle for a value of 6 pixels.
Now move the Threshold slider to the right until the spots begin to reappear. Settle for a value of around 25 levels and click on OK.

Note
The degree of success you have with the Dust & Scratches filter depends largely on the image or selection to which you apply it.

Applying the Dust & Scratches filter selectively
Although the spots and scratches are mostly gone and the grain restored, you probably notice that some of the important detail has been eliminated. The reason is that the Dust & Scratches filter can’t tell the difference between a scratch and an eyelash!

To remedy this problem, we’ll use a Layer Mask to hide the filtered image and then 'burn holes' in it to apply the filter only to the damaged areas of the image.

6.4 Go to Layer / Layer Mask / Hide All. You should see a new, black-filled Layer Mask in the Layers palette (Figure 19).

- Make sure the Layer Mask thumbnail is active (it should be framed within a double-line border); click on it if it’s not.
- Make sure foreground colour is set to white in the Set foreground / background color tools located in the Toolbox (use the double arrow in the top right corner to inverse foreground and background, if necessary).
- In the Toolbox, choose the Brush Tool (Figure 20) and in the Options bar at the top of the screen, set Opacity and Flow to 100%.
- Click the triangle next to the Brush Preset picker and choose a soft-edged brush tip about the size of the specks you need to hide (about 17 px).
- Dab with the Brush Tool where you see specks in the image.
Notice the changes on the Layer Mask thumbnail in the Layers palette.

**Note** The dabs are like burning little white holes in the mask, allowing the filtered image to cover the spots in those areas.

### Using the Clone Tool to correct the remaining blemishes

Next you will add a “repairs” layer above the filtered layer, where you can make your “hand-painted” alterations. This protects the image from painting mistakes and also makes it easy to make changes to your repairs later if you need to.

6.5 Add another layer by clicking on the Create a new layer icon at the bottom of the Layers palette. Choose the Clone Stamp Tool in the Toolbox, and in the Options bar set the Opacity to 100%, and select the Use All Layers check box (Figure 21).

![Brush Preset picker](image)

Figure 21 - the clone stamp tool option bar

- Click the triangle next to the Brush Preset picker and choose a soft-edge brush tip (for example, 17 px) about the size of the specks you need to hide.
- To start the repairs, hold down the <Alt> key and click in an area near the flaw you want the repair to sample from. Release the <Alt> key and move the cursor over to the point where you want to clone to and click, several times if necessary, to cover the flaw.

**Note** The Clone Stamp Tool works by sampling content in an area and copying (cloning) them to a damaged area. This is a fiddly job which requires frequent sampling, but which can ultimately give excellent results. Unchecking the Aligned option allows the same sample to be pasted again and again anywhere on the image. When checked, a map of the whole image will be stored.

### Adjusting contrast and sharpening

Finally, you could refine your image by adjusting tone, colours and sharpening using the methods described in Tasks 3 and 4.

For this task, we are simply going to apply a “quick fix” to adjust the image contrast.

6.6 Click the Create new adjustment layer icon at the bottom of the Layers palette and choose Levels.

- Click on Auto and then click on OK.

6.7 Save your image:

- Go to File / Save As.
- In the Save As dialogue box, navigate to: C:Training\Graphics.
- Save your file as old_image_after as a JPEG with maximum quality.

6.8 Open old_image_before.jpg to compare it side by side with old_image_after.jpg. Observe the differences.
Task 7  Blending images using a layer mask and gradient

Objectives  To merge images together in a smooth transition.

Comments  This technique is ideal for creating seamless photomontages.

Creating a new document

7.1  Create a new file:

➢ Go to File / New. In the New dialogue box, give your new image a name (e.g. firstmontage), set the Width to 300 pixels and Height to 100 pixels, the Color Mode to RGB Color and Background Contents to White (Figure 22).

![New file dialogue box](image)

Figure 22 - New file dialogue box

7.2  Move images to the new document:

➢ Open the image library.jpg located in C:\Training\Graphics\.

➢ Using the Move tool (see right), drag the image library.jpg on to the new blank image.

Notice that a new layer containing the image has been created above the white Background layer.

Note  If rulers are not displayed, click View / Rulers. Right-click somewhere inside the ruler and set the unit of measurement to Pixels.

7.3  Resize the image to make it smaller:

➢ Ensure the top layer is selected in the Layers palette. In the Edit menu, select Transform / Scale.

This will display sizing handles around the image – if you cannot see the handles, you can increase the canvas size by dragging its edges.

➢ Hold down <Shift> to preserve the aspect ratio, and move the corner points inwards until you can see enough of the student in the image.
As you do this, you can reposition the image by placing the cursor inside the transform boundaries, pressing the left button and dragging. Drag the image to the right of the canvas, leaving approximately 1/3 of the canvas uncovered and experiment with vertical alignment until you are happy with the position of the student (see Figure 23).

Figure 23 - scaling down and positioning the library image

- Click <Enter> to commit the change. At this point, you can reposition the image if you wish.
- Use the move tool to left click in the left ruler and drag to the right to set a guide (blue line) at the left-hand edge of the photograph.

Note If the image keeps snapping to edges of the canvas, turn the Snap feature off by selecting View / Snap and making sure the Snap option is unchecked. Repeat this process to reset it if required.

7.4 Repeat steps 7.2 and 7.3 with the image **computer.jpg**, aligning it left, overlapping the library image and setting the It should cover just over ½ the canvas (see Figure 24). The guide should be set against the right edge of the photograph.

Figure 24 - two overlapping layers with guides to highlight edges

Note It is important that the images overlap sufficiently for the blending effect to work.

**Blending the images**

7.5 Blend the images as follows:

- In the menu bar at the top, go to Layer / Layer Mask / Hide All to add a layer mask. You should now see the layer mask as illustrated in Figure 25.
This renders the layer invisible, indicated by a black thumbnail in the layers palette.

Various tools can be used to ‘paint the layer back’. In this case, the **Gradient Tool** is used to achieve a smooth transition from transparent to fully visible.

- Having made sure the foreground colour is set to black, select the **Gradient Tool** (if you can’t see it, right-click on the **Paint Bucket Tool** and select it).
- Make sure the layer mask (black thumbnail) is highlighted in the **Layers** palette, by clicking on it once. If the image icon itself is highlighted, a colour gradient will flood the layer.
- Place the cursor just inside the right-hand guide image (roughly in the middle, vertically). Click and hold down the left mouse button and drag the mouse to the left, in a straight, horizontal line, stopping just before reaching the left guide, and release.

You will notice the computer image gradually appearing. The image becomes 100% visible at the point at which the mouse is released. You will notice that the black thumbnail now displays the applied gradient (Figure 26).

If you are unhappy with your gradient, simply click and drag the mouse again. The shorter the drag, the less gradual the transition between invisible and opaque.

From the menu, select **View / Clear Guides**. Your blended image should look something like Figure 27.
7.6 Link the two layers:

- In the Layers palette, select one of the image layers, press <Shift> and select the other image layer.
- With the two image layers selected, click on the Link layers icon at the bottom of the Layers palette (Figure 28).

![Link layers icon](image)

**Figure 28 - Linking the two image layers**

Notice the link symbol now displayed to the right of each image layer, indicating that these layers are linked.

**Note** Linking layers is particularly useful when you want to apply the same changes (e.g. repositioning, styles, etc.) to several layers.

7.7 Merge the layers:

- In the Layers menu, select Merge Layers. As a result the two linked layers will become one (Figure 29).

![Merged linked image layers](image)

**Figure 29 - Merged linked image layers**

- Save the image as firstmontage.psd in C:\Training\Graphics\.
Task 8 Working with text layers

Objectives
To add and manipulate text layers.

Comments
You can create type (text) anywhere in an image in Photoshop. When you create type, a new type layer is added to the layers palette. You can then manipulate it like any other object (image, shape, selection, etc), and the text itself will remain editable.

Adding a text layer

8.1 Create a new image with dimensions 400px x 400px with a white background (see task 7.1)

8.2 Activate the Type tool:
- In the Toolbox, select Type tool and left-click inside your new canvas.
- In the Type tool Option bar (Figure 30) click on the Set the text color option and pick colour for your text:

![Set the text color](image)

Figure 30 - the Type tool option

- Choose a font family, style and size from the font options (for example Arial, 18pt, bold, Sharp).

Note
Working at different image resolutions will result in variations in apparent text size. For example text will appear much smaller in a 300dpi image than in a 72dpi (typical screen display resolution) image.

8.3 Add some text:
- Click inside the canvas, toward the top left and note the automatic addition of a new layer in the layers palette.
- Type your name (Figure 31). To deselect the Type tool, click the Commit icon in the Tool Options menu. You should notice the text in the layers palette change to match the name you have typed (Figure 32).

![Joe Bloggs](image)

Figure 31 - Example of type layer

![Joe Bloggs](image)

Figure 32 - Type layer indicated in layers palette
8.4 Set anti-aliasing:
- Make sure the type layer is selected in the layers palette and select the Type tool.
- Experiment with the anti-aliasing options on the drop-down menu on the tools options menu), noting how the text changes, settling with which ever you feel renders the text most clearly.

**Note** Anti-aliasing smoothes jagged edges by adding shading or colours.

8.5 Reformat and edit the text:
- Making sure the type layer is highlighted, select the Type tool and click just to the right of the final letter of your text.

**Note** It is important you do not click anywhere else in the document; this will result in the creation of a new text layer
- Hold down the left mouse button and drag to highlight all of the text.
- Experiment with font faces, sizes, colours and anti-aliasing options.
- Left-click within the text and use the keyboard to change your name to **Joe Bloggs**

**Adding a text box**

8.6 Use the shape tool to create a box with a drop shadow to set it away from the background:
- Create a new layer (see Task 1.5).
- Select the Shape tool in the Tool Box.
- In the Tool Options menu, make sure the Fill pixels and Rectangle tool icons are selected (Figure 33).

![Fill pixels and Rectangle tool selected](image)

**Figure 33 - Fill pixels and Rectangle tool selected**
- Set the foreground colour by clicking the foremost square on the colour picker and choosing a pale colour from the palette.
- Working on the layer you have just created, place the cursor below the text you have already created, hold down the left-hand mouse button, and draw a rectangle, large enough to accommodate your text.

**Note** Hold down the shift key when dragging, to achieve a perfect square
- Add text, as per task 8.2

8.7 Resize and move the text box if necessary:
- Make sure the Shape (text box) layer is selected in the Layers palette and go to Edit / Transform / Scale to display sizing handles.
- Drag the sizing handles to resize the image to accommodate the text above, and either press the return key, or click the Commit icon in the Tool Options menu.
- Select the Text layer in the Layers palette and use the Move tool to position the text inside the box.
Note: In order that your Shape layer does not obscure the text, make sure that it is below the Text layer in the layers palette. To reorder layers, simply drag them up or down in the Layers palette.

8.8 Add a drop-shadow:

- In the Layers palette, make sure the Shape layer is selected and click the Add a layer style icon at the bottom (Figure 34).

![Add a style layer icon](image)

**Figure 34 - the Add a layer style icon in the Layers palette**

- From the pop-up menu, select Drop Shadow. This will launch the Drop Shadow Options palette, adding a default shadow to the text.
- Experiment with the Structure options (Blend Mode, Colour, Opacity, Angle, Distance, Spread and Size) and click the OK button when you are happy (Figure 35)

Note: Layer styles are applied to every object within a layer. For example, two shapes on one layer will both acquire a drop shadow.

You may wish to link the two layers to maintain their relative positions (see task 7.6)

![Text box](image)

**Figure 35 - Text box**

Further text editing is possible via the Paragraph and Character palettes (open by clicking the Toggle the Character and Paragraph palettes icon on the Type Tool Options bar. The Paragraph palette enables line spacing, alignment and so on to be set. The Character palette provides a shortcut to several formatting elements also found elsewhere (anti-aliasing, font colour, font size etc.)

You can also warp text in many different ways by using the Create warped text option. Feel free to experiment with these.

8.9 Minimise the image for reference throughout task 9.
Appendix 1  Creating a customised map for a CMS website

Examine an existing customised University map

- Open the following page in a web browser:
  http://www.bris.ac.uk/is/locations/findus/branchlocations.html
- Note the use of numbers and letters to denote locations of branch libraries and other Information Services resources around the University. These have been added to a blank, generic map of the University.

Note  Numbering and text may be added to the map to customise it, but for consistency, it is requested that no other alterations be made.

Open and prepare a local version:

- Open the image precinct-map.tif in C:\Training\Graphics\
- Go to Image / Mode / RGB Color
- Go to Image / Image size to display the palette shown in Figure 36.

Note  The image mode has been set to CMYK, for printing, and should be changed to RGB for screen display. For further information see the Colour Management section on page 6.

![Image Size palette](image.png)

Figure 36 - Image Size palette

- Make sure all boxes are checked and the Resample Image menu displays Bicubic Smoother.
- Set the Width to 800 pixels, noting the Height change accordingly (proportions have been constrained).
- Click OK
Using the **Zoom tool** in the **Toolbox**, click on the map to zoom into the area around your own department/unit at 100% image size (see Figure 37 and Figure 38). Hold down the `<Alt>` key whilst clicking, to zoom out if necessary.

**Figure 37** - Map detail showing Tyndall Avenue and St Michael's Park

University buildings are shown as white shapes. For example, Figure 37 shows, from left to right:

- Senate House
- Sports Hall
- Computer Centre
- Arts & Social Sciences Library

**Customise the map for your department or unit**

- Using the elements covered in task 8, add appropriate text to label the map, using text boxes to overcome space issues.

You may wish to use the **Line tool** to point the box to buildings. This can be found within the **Shape tool options menu** – see Figure 39)

**Figure 39** - Line tool selected in Shape tool options menu

To add arrowheads to lines, click the small triangle to the right of the shapes to select from the drop-down menu shown in Figure 40.
Save your map:

Go to File / Save for Web and select file type GIF, with 256 colours (see Figure 41).

- Click Save, saving the file as localmap in C:\Training\Graphics\
Appendix 2  Resolution and image size for printing

<table>
<thead>
<tr>
<th>Pixel size</th>
<th>Megapixels</th>
<th>RGB size (MB)</th>
<th>CMYK size (MB)</th>
<th>150 ppi</th>
<th>300 ppi</th>
</tr>
</thead>
<tbody>
<tr>
<td>1600 x 1200</td>
<td>2</td>
<td>6</td>
<td>7.5</td>
<td>11 x 8 inch (28 x 20 cm)</td>
<td>5.5 x 4 inch (14 x 10 cm)</td>
</tr>
<tr>
<td>2400 x 1800</td>
<td>4.3</td>
<td>12.5</td>
<td>16.5</td>
<td>16 x 12 inch (40 x 30 cm)</td>
<td>8 x 6 inch (20 x 15 cm)</td>
</tr>
<tr>
<td>3000 x 2000</td>
<td>6</td>
<td>17.5</td>
<td>23.5</td>
<td>20 x 13 inch (51 x 33 cm)</td>
<td>10 x 6.5 inch (25 x 16.5 cm)</td>
</tr>
<tr>
<td>3500 x 2500</td>
<td>8.75</td>
<td>25</td>
<td>33.5</td>
<td>23 x 17 inch (58.5 x 43 cm)</td>
<td>11.5 x 8.5 inch (29 x 21.5 cm)</td>
</tr>
</tbody>
</table>

Table 1 - comparison of pixel resolution, megapixels, megabyte file size and print output dimensions at different resolutions in inches (and centimetres)

<table>
<thead>
<tr>
<th>Output use</th>
<th>Screen ruling</th>
<th>x 1.5 Standard quality output resolution</th>
<th>x 2 High quality output resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Newspaper</td>
<td>65 – 100 lpi</td>
<td>97 – 150 ppi</td>
<td>130 – 200 ppi</td>
</tr>
<tr>
<td>Books</td>
<td>120 – 150 lpi</td>
<td>160 – 225 ppi</td>
<td>240 – 300 ppi</td>
</tr>
<tr>
<td>Colour magazine</td>
<td>150 – 175 lpi</td>
<td>225 – 262 ppi</td>
<td>300 – 350 ppi</td>
</tr>
<tr>
<td>Art book/magazine</td>
<td>175 – 250 lpi</td>
<td>262 – 375 ppi</td>
<td>300 – 500 ppi</td>
</tr>
<tr>
<td>Photo quality inkjet printer</td>
<td>150 – 300 lpi</td>
<td>225 – 450 ppi</td>
<td>300 – 600 ppi</td>
</tr>
</tbody>
</table>

Table 2 - rule of thumb screen resolutions for common print devices at lpi x 1.5 and x 2 quality factors

Example

Say you want to print a high quality A4 photograph on an inkjet printer:

A4 size = Width 8.268 x Length 11.693 inches (21 x 29.7 cm)

Printer resolution = 200 lpi

Quality factor = x 1.5

Print length x Printer resolution x Quality factor = number of pixels required in length

11.693 x 200 x 1.5 \approx 3500 pixels in length

Print width x printer resolution x Quality factor = number of pixels required in width

8.268 x 200 x 1.5 \approx 2480 pixels in width
Appendix 3  Further resources

Adobe's Photoshop tutorials
These tutorials cover most things you can do in Photoshop, including some useful tutorials on image enhancement and restoration:

Web Photo Resizer
This is a free online tool for resizing and optimising images for the Web. Features include cropping, rotating, sharpening and contrast/brightness adjustment:
http://www.webresizer.com/

PIXLR
PIXLR's image editor offers online layers-based image creation. Features include text, cloning, filters and adjustment layers:
http://www.pixlr.com/editor/